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About Excel Post-estimation Workbooks

XPost is aseries of Excel workbooks that simplify the post-estimation interpretation of regression models
for categorical outcomes. The workbooks implement the procedures suggested in:

J. Scott Long, 1997, Regression Models for Categorical and Limited Dependent Variables,
Thousand Oaks, CA: Sage Press. (Abbreviated as RMCLDV).

Each workbook includes an example from this book. These workbooks and the documentation you are
reading can be obtained at: www.Indiana.edu/~jsl650/post.htm

General Introduction

All of the X Post workbooks work in approximately the same way. First, you enter the estimates computed
by a statistical package. Which package you use to estimate your model does not matter. Second, you
specify which post-estimation information you want and Excel does the computations. The following
documentation begins with the basic ideas that apply to al of the workbooks. We then give detailed
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instructions for the binary logit workbook. Finally, less detailed information is provided for each of the
other workbooks.

The Workbooks

XPost is currently a set of six Excel workbooks: blogit.xls, bprobit.xls, ologit.xIs, glogit.xls, mlogit.xIs,
and count.xls. These workbooks provide post-estimation analysis for the binary logit, ordered logit,
generalized ordered logit, multinomial logit, and two count models (Poisson and negative binomial
regression). Versions of the workbooks for other models are planned. In each workbook, you enter the
estimates from your model and Excel computes post-estimation statistics, including graphs of predictions.
The workbook instructions.xls contains technical documentation for those who want to make major
changes to how the workbooks operate.

Each workbook has five worksheets, indicated by the tabs at the bottom of the screen. Hereafter, we refer
to these sheets by their name, shown in italics. For example, the worksheet Input will be referred to
simply as Input. In Input you enter information from the estimates for your model. Calculator computes
predicted values at specified values of the independent variables. Plotter plots predicted probabilities as
one variable changes holding all other variables at specified values. Change cal cul ates the factor and
discrete changes in the outcome for given changes in the independent variables. Finally, each workbook
has a hidden sheet called Tech that does the calculations. Interested users can find the hidden page by the
following these menu options. Format = Sheet - Unhide = click OK. (Note: When presenting menu
options for Excel, we list the text name on the menu with the hotkey |etter underlined. For example,
Format indicates the format list on the menu, which can be accessed by pressing [alt-0]). If you change
anything on this page, the results are unpredictable and almost certainly incorrect.

Copying a Template

The workbooks that we provide should be used as templates that are not changed. Instead, copy a
workbook to a file with a different name and make changes only to the new file. For example, if you want
to calculate post-estimation results for abinary logit in a project concerning high school students going on
to college, copy blogit.xIsto college.xIs. Or, load blogit.xIsin Excel and renameit: File > Save As >
Type college.xIs and press Enter.

Loading a Workbook
When you load a workbook, Excel asksif you want to enable macros in the workbook. Y ou must click on

St (=SS or the workbook will not make the cal cul ations.

Entering Estimates into a Workbook

To use aworkbook, you must enter the names and estimates from your model to the Input sheet. When
you enter the estimates, you should use al of the decimal digits that are available from your output; if you
do not, significant rounding errors can occur. In XPost you should only enter information in areas that are
light green (these will appear as pale gray in the pictures below).

Since entering alot of information is error prone, we recommend that you copy the estimates from your
text editor and paste them into Input. We use TextPad (www.textpad.com) and illustrate how to paste
information from this program. Other editors work similarly. Y ou can use Microsoft Word for making
block copies. To do this, hold down the “ Alt” key and use the mouse to select text.

In what follows, we demonstrate only the most basic way to copy and paste information. Experienced
users can use tricks to make this faster. For example, thein Excel the sequence: Data > Text to Columns
makes it possible to paste multiple columns.
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1) Open your output file in TextPad. Enter the commands: Configure - Block Select Modeto turn on
block select mode. Then highlight the block of text you want to select. Press[Ctrl-c] to copy the selected
information. Here we begin by copying the names of the variables:

& TextPad - [D:\XPost\output.log] _ O] x|
5| File Edit Search View Tools Macros Configure Window Help =]
Ordered logit estimates Number of obs = 1032
LR chi2(39) = 750.31 —
Prob > chiz2 = 0.0000
Log likelihood = -1367.6995 Pseudo R2 = 0.2153
sexpo | Coef Std. Err z P>zl [95% Conf. Interval]
————————— +————--————--————--—————--————--—————-—————--————--—————-—————--————-
female | . 154681 . 125542 1.232 0.218 -.0913768 .400T7388
catholic | .4383327 .3156481 1.389 0.1865 -.1803261 1.056992
private | .1942328 2422257 0.802 0.423 -.2805209 .6689865
reading | .B127518 .010275 1.2 0.215 -.0073867 .0328905 |
math | .DYE3626 .01608458 4.275 0.000 .B251052 .BETBE195
gmath | .1215213 .0436983 2.781 0.005 .0358742 .2071684
geng | . 1650454 0486797 3.390 0.001 .069635 .2604558
ddadvoc | 3044404 .2753546 1.106 0.269 =.2352446 . 8441255
ddadsco | .B840595 .2795916 0.301 0.764 -.4639299 .6320489
ddadcol | .1918914 .2200818 0.872 0.383 -.2394609 .6232438

2) Switch to Excel and move your cursor to the first cell containing the names of the variables on the
Input sheet. Thisiswhere you will paste the information you copies from TextPad.

© Tip: [Alt-Tab] switches between opened programs without touching the mouse.

% File Edit Wiew Insert Format Tools Data Window Help == x|
| BI6 ~| =| K5
A B Z D E F ] H |
12 Table 2. Estimates, Descriptive Statistics, Variable Types, and Base Values
13 Logit Std Variable
14 Variable iZoefs Z-valle hWlean Dey Min Ml Type

15 Constant 3182 4 94
16| | K5| -1463 -7 43 0.24 n&2 0.00 3.00

c il
17 K618 -0.065 -0.95 1.35 1.32 0.00 8.00 C Ml
18 Age -0.063 -4.92 4252 8.07 30.00 650.00 C Ml
19 wc 0.807 351 028 045 0.00 1.00 B Ml
20 HC 0.112 054 0.29 0.49 0.00 1.00 B Ml
21 Lwg 0.605 4.01 1.10 058 -2.05 322 c Ml
22 Inc -0.034 4.2 2013 11.63 -0.03 96.00 c il
23 -
4 4 » | M\ Input / Caleulator / Plotter / Change / |< | >||_

Ready
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3) Paste the information by pressing [Ctrl-v]. Notice in the picture below that the example data that was
included in the workbook is being replaced by new information.

X Microsoft Excel - Blogit [_[O] x|
”E Eile Edit ¥iew Insert Format Tools Data Window Help == x]
BI6 ~| = female
Al B [ ¢ [ b [ E [ F [ & | H [ 1 |

12 Table 2. Estimates, Descriptive Statistics, Variable Types, and Base Values

13 Logit Std Variable

14 YVariable Zoefs Z-value Mlean Dey MAin Ml Type

15 Constant 3182 494

16 female -1463 -T43 0.24 052 0.00 3.00 C

17 catholic -0.065 -0.9% 1.35 1.32 0.0o 2.00 i

18 private -0.063 -4.92 4252 2.07 20.00 £0.00 i

19 reading 0807 351 0.28 045 0.0o 1.00 B

20 math 0112 054 0.39 049 0.0o 1.00 B

21 gmath 0.605 401 1.10 059 -205 322 i

22 geng -0.034 42 2013 1163 -0.03 96.00 C

23 ddadvoc

M|« » MMNInput/ Calculator / Flotter / Changs / | 1 |

Ready = | |

4) Continue this process copying and pasting information for the other columns.

z-value. Enter the z-values associated with each of your coefficients. Thisinformation is optional.
Mean. Enter the mean values for each right hand size (RHS) variable.

d Dev. Enter the standard deviations of your RHS variables.

Min. Enter the minimum for each variable; enter O if the minimum is unknown.

Max. Enter the maximum for each variable; enter O if the maximum is unknown.

Variable Type. Enter "c" if the variable is continuous; "b" if binary.

Base Value. The base values are used to compute post-estimation statistics. Since the models are
nonlinear, the values of the base values will affect the value of the statistics that are computed on the
Calculator, Plotter, and Change pages. Y ou can enter use the abbreviations: m = mean; min =
minimum; max = maximum

For Variable Type and Base Value you should not include spaces since these will confuse Excel.

© Tip: XPost includes comments to help you remember what

vari ablr; !nformation should be entered. Thesg are shown by small red triangles
‘\ in the upper right corner of acall, asillustrated to the left. If you hold
Type the cursor over the triangle, asmall help screen will be shown.
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Pasting Values from Stata

If you are using Stata to estimate your models, you can use the program xpost.ado that we have written to
make it simple to transfer results from Stata to X Post. This program can be obtained by following the
instructions for installing the Stata package SPost at: www.indiana.edu/~jsi650/post.htm . To use xpost,
simply type the command after estimating the model of interest. xpost will rearrange the output so that the
rows and columns of output correspond to the rows and columnsin XPost. Y ou can then use the Data >
Text to Columns command in Excel.

Case and Spaces

Excel isnot case sensitive, but extra spaces are considered to be part of the information you enter. For
example, when pasting in names if you paste in spaces after the name, you must include those spaces
when you refer to that name on other worksheets. The simplest thing is to remove extra spaces entered in
the columns Variable, Variable Type, and Base Values. It is easy to remove extra spaces with Excel’s
Replace command. To do this, highlight the area you want to clean, and enter the commands Edit >
Replace. A dialogue box will pop up as shown below. Enter a space in the Find what box, then click
Replace All .

© Tip: XPost has an even easier way to remove spaces. X Post creates its own menu, called (aptly

enough) XPost. To access the menu, press[Alt-p]. Select the option Replace spaces. Alternatively, simply
press the keys [Ctrl-Shift-r].

Table 2. Estimates, Descriptive Statistics, Variable Types, and Base Values

Logit =td Yariable
Variable Coefg Z-value hean Dev tin ha Type
Constant 3182 .94 - -
female —— i s E— m— — C
catholic Replace 2lx] ¢
pr‘r’v._zre Find what: C
reading I E
math Replace with: Close | B
gmath | C
geng R—L'acel C
ddadvoc Search: IB\; Rows | T Match case Penlace Al
ddadsco I~ Find entire cells anly ﬂl

Adding Comments

If you want to add notes to a worksheet (e.g., document what the sheet contains), make sure these notes
are entered in the areas that are above the line separating rows 11 and 12. Some areas under this line have
hidden codes. Changing these codes will create errorsin your calculations.
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Do not Add or Delete Rows or Columns
Adding or deleting rows and columns to the sheets can lead to unpredictable results.

Pull-down Menus

For each worksheet, a pull-down menu is created by pressing [Ctrl-Shift-p] . The menu includes:
e Reset Pull-Down Menu. Allows you to hide the pull-down menu.

¢ Replace Space. Will remove extra spaces.

e Show/ Hide Calculator. Allows you to hide or to show the Calculator sheet.

e Show/ Hide Plotter. Allowsyou to hide or to show the Plotter sheet.

e Show/ Hide Change. Allows you to hide or to show the Change sheet.

e About and Help Sources: Indicates the current version of the workbook.

Changing the Active Sheet

After you have entered your estimates into Input, you can use the other sheets. To move from sheet to
sheet, click the sheet tabs. The current sheet is shown in white, with the other tabsin gray:

17 K618 0065 -0.95 1.35
18 Age -0063 -4 92 42 52
M| 4 » M Input/ Calculator / Plotter / Change /
Ready

Save Your File

As usual, remember to save your file when you are done with your work.

blogit.xls: Binary Logit

The Input Sheet

First, enter the information for Table 1, which describes your dependent variable. Since these statistics are
not used in other computations, entering thisinformation is optional, but recommended.

Table 1. Descriptive Statistics for Y - opliona!l -

MName Mean Std lin hlax
3 LFFP 057 050 0.00 1.00
11

Second, enter the statisticsin Table 2. Details are given in the General Overview.
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The Calculator Sheet

There are two tables on this sheet. Table 1 contains predicted probabilities calculated at values of the
independent variables that you have specified. Table 2 lists the base values that you entered on Input in
the column Base Values. If you want to change these values, you must do so on the Input sheet.

“E File Edit View Insert Format Tools Data Window Help =|=| x|
Viocl ~| = k5
Bl C| D | E | F B K |

11

12 Table 1. Predicted Probability Table 2. Base Values

13 All Variables Basic

‘!ﬂ Held af Probabilifies Variables Valles

16 Ease 0578 K5 024

17 Mean 0578 K518 1.35

18 bAinimum 0513 Age 4252

19 Maximum 0.003 WY 0.28

20 HZ 039

21 With ofher variabios held at the base vaiuses, Lwg 1.1

22 vany the folfowing variables and calcwiate Inc 2013

23 ihe predicted probabilifies.

24 L0 0 661

25 L 0311

26 1 K5 . 0.095

27 3 0.024

% | N 0006

29 0 0522

30 A 0.710

31 2 We

33 Jﬂ
l4| 4| » M} Input ' Calculator ¢ Plotter / Change /

Ready I R

At thetop of Table 1, predicted probahilities are calculated with al independent variables held at their
base values (as set on the Input sheet), means, minimums, and maximums, respectively. In the second part
of Table 1, you can pick up to three variables and specify up to five values for each variable. Note that the
names of your selected variables must be exactly the same as the variable names in Input. Extra spaces
count. The predicted probabilities are calculated with all other variables held at their base values.
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The Plotter Sheet

This sheet plots plot predicted probabilities as one variable changes holding other variables at fixed
values. The plot isastandard Excel chart. This means that you can use all of the toolsin Excel to modify
the format of the chart. Indeed, most people will want to modify the chart the X Post creates. For example,
we have found no way to force the maximum value of the x-range to equal the maximum that you specify
or to allow the user to specify the name of the x-axis. But, all of these can be control by using standard
charting toolsin Excel.

X Microsoft Excel - Blogit [_[O] %]
“E Eile Edit View Inset Format Tools Chart Window Help ;lﬂlil‘
Chart Area ﬂ = ‘
sl B [ ¢ | o [ E [TF[ & [ H [ 7+ [ 4o [ k [ L [ ™M [ J
] Table 1. Specification of x-variable.
Z K-variable to vary Inc With other variable at the base, vary this variable.
8 Start Value 0 Enter the start value for the x-axs.
E End Yalue 100 Enter end value for the x-axis
10 # of Points 15 2 to 20 points allowed
E
| 12| Table 2. Specification of control variable. Figure 1. Predicted Probability
| 13| Value Cunse F . 1
14 Curnve # i Variabia Fixed at Labai —e—hge 30 —$—Agedl A Age S0 —=—Age b0
ﬁ Curve 1 Age an Afe 30 —H—drep —e—drop
17| | cuve2 | Age 40 Age 40 ;gg
|18 | Cuve3d | Age 50 Age 50 080 e
19| | Curved | Age 60 Age 60 s S N
120 | Curves drop b £ 060 '*‘\A;\"\::'\\
| 21| Curve 6 drop % Ejsi\‘ \A\ \ \'\‘
| 22| % 0.a0 e R N e
| 23 | & 020 =
0.10
| 25 | 0.00 20.00 40.00 £0.00 80.00 10000 12000
ﬁ ¥-Wariable
27 u m
4« [» [M] Input /7 Caleulater b Plotter  Change /
Ready

1. Enter theinformation in Table 1 on the variable that will be plotted on the x-axis. Thefirst row requests
the name of the “x-variable to vary.” Enter the name of one of your independent variables, usually a
continuous variable. Remember that extra spaces cause a problem. In the second and third cells, enter the
start and end values of your x-variable. Check your descriptive statistics to see the range of this variable.
Finally, enter the number of points you want to plot in the fourth cell. This determines the number of
symbols (e.g., circles, triangles) shown on the plot. Asyou enter this information, the plot will change
immediately.

2. Up to six curves showing the predicted probability as the x-variable changes can be plotted. Each curve
corresponds to specified levels of the other (i.e., not the chosen x-variable) variables. Each curveis
defined by the level of one other variable. For example, in the figure above, the predicted probabilities of
being in the labor force are plotted as income changes from $0 to $100,000 at four different ages of the
respondent. We have labeled the fifth and sixth curves as “drop” to indicate that you will want to remove
these curves from the plot.
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In the column Variable, enter the name of the variable whose value you wish to change from the base
values specified on Input. In our example there are four levels of age, but the curves do not need to be for
different levels of the same variable. That is, you could also include a curve in which the value of some
other variable is specified. The specified values of the variable are given in the Value Fixed At column
and alabel for the curveis givenin the last column.

To create asingle curve, you have to trick the program. To do this, delete all of the information in Table 2
except for Curve 1. For Curve 1, enter any variable, and in the Value Fixed At column, enter the base
value from Input.

3. Tables 3 and 4 are shown beginning in column S. Table 3 reproduces the base values from Input. Table
4 shows the values that will be plotted. Y ou cannot make changes directly to either of these tables.

Modifying a Plot
Theplot islike any other chart in Excel. That means, you can customize it using the standard Excel tools
for charts.

The Change Sheet

This sheet calculates factor and discrete changes. Table 1 shows the factor change in the odds for changes
in each independent variable. Table 2 displays the discrete changes in the probabilities. In this table, all
predicted probabilities are calculated with all variables held at their base values as set on Input. Discrete
changes from 0 to 1 are not calculated if the variable is continuous. For dummy variables, centered unit
change and centered standard deviation change are not calculated. Remember, changing the base values
must be done on Input. Table 3 shows the current base values for each of your independent variables.

bprobit.xls: Binary Probit

This workbook operates almost exactly like blogit.xls, with two exceptions. First, you enter estimates
from the probit model (obviously). Second, bprobit.xls does not compute factor change coefficients since
these are not appropriate for the probit models.

ologit.xls: Ordered Logit

The Input Sheet
First, enter into Table 1 the descriptive statistics for your dependent variable. While thisis optional, it is
recommended.

Table 1. Descriptive Statistics for Y - optional -

Marme hean Std hlin hlax
WARM 251 0.93 1.00 4.00

Second, enter into Table 2 the estimated cutpoints and the names of the dependent categories.
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Table 2. Cutpoints & Category Names

Dependent
Cutpoints Category Names
o 245 | y=1 S0
Ta -0.6309 2 DA,
T3 1.2619 3 A
T4 4 54,
Ts o]
Ts b
T 7
Tg 8
Ta 3
Tin 10

The values estimated for the cutpoints will depend on the parameterization used by the program that
estimates the model. Some programs fix the constant to 0 and estimate the first cutpoint; thisisillustrated
above where the value -2.465 is entered for 1, and the constant is entered in Table 3 (shown below).
Alternatively, some programs fix ;=0 and estimate the constant. In this case, enter 0 in Table 2 for t; and
enter theintercept in Table 3.

Third, enter into Table 3 estimates of the regression coefficients and descriptive statistics for the
independent variables. Note that up to 50 independent variables are allowed. With the exception of the
caveat regarding the constant, the information in Table 3 is entered in the same was as for blogit.xls.

Table 3. Model Estimates, Descriptive Statistics, Variable Types, and Base Values
Logit otd “ariable Base
“ariahle Coefs  z-value Mean Dev Min Max Type Yalue
Constant -

YRED 0.524 B.560 0.400 0.430 0.00 1.00
MALE 0733 9340 0.470 0.500 0.00 1.00
WHITE -0.351 -3.300 0.530 0.330 0.00 1.00

AGE 0022 5780 44940 16.780 18.00 §9.00

ED 0.067 4200 12220 3.160 0.00 20.00
PRST 0.006 1.840 39.590  14.450 12.00 §2.00

3 x M m OD
===z ==

The Calculator Sheet

This sheet operates in the same way as blogit.xls except that for ologit.xIs there are predicted probabilities
for multiple dependent categories.

The Plotter Sheet

This sheet operates in the same way as blogit.xls except that for ologit.xls there are plots for multiple
dependent categories.
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The Change Sheet

This sheet operates in the same way as blogit.xls except that for ologit.xls there are discrete change
coefficients for multiple dependent categories. The factor change indicates the factor change in the odds
for being in higher categories versus lower categories.

oprobit.xls (to be added): Ordered Probit

Thisworkbook works in the same way at ologit.xls. The only differences are that you enter estimates
from the ordered probit model and factor change coefficients are not appropriate.

mlogit.xls: Multinomial Logit

While mlogit.xIsis similar to other workbooks, you need to be very careful that you understand the base
category used in estimating your model. Thisinformation is entered on Input.

The Input Sheet

First, enter into Table 1 the descriptive statistics for your dependent variable. While thisis optional, it is
recommended.

Second, when estimating the multinomial logit model, the estimated coefficients show the effect of a
variable on a given outcome relative to a base category. The choice of the base category will affect which
coefficients are estimated. Different programs select the base category in different ways. While the choice
of abase category is arbitrary, you must know what the base category is. See Long (1997: 157-158) for
information on determining the base category used by your software. In mlogit.xls, you enter the name
(which can be anumber) of your base category:

Base Categony =

Third, enter the descriptive statistics, variable type, and base values for the independent variables. Thisis
donein the same was as for other models.

Fourth, enter the estimated logit coefficients in Table 3. Note that the number of equations (indicated by
the columnsin thetable) is equal to the number of dependent categories minus 1. Each coefficient
compares a“ given outcome category” to the base category specified earlier. Be sure to indicate the “given
outcome category” in the header of each column.

Table 3. Estimates of Logit Coefficients
Dutcome category relative to the base category:

Contrast Grodp BlueCol Craft  WhiteCol prof
Constant 0.741 -1.051 -6.238  -11.518
WWHITE 1.237 0472 1.571 1.774

ED -0.035 0.094 0353 077

EXPER 0.005 0028 0.035 0.03k

The Calculator Sheet

There are two sets of calculations given on this sheet. First, factor change and standardized factor change
in the odds are presented in Table 1. In the multinomial logit model, you can estimate the factor change in
the odds of any outcome category relative to any other outcome category. In many statistical packages
these coefficients are presented for each dependent category relative to the base category. In thistable you
can request factor change coefficients for any four pairs of outcome categories, referred to as “ contrasts”
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in the table. In the green cells, shown as gray below, enter the names of the outcomes that you want to
compare. Note that you must enter the names exactly as they were entered on the input sheet. Here we

show only part of Table 1.

Table 1. Logit Coefficients and Factor Change of Other Contrasts

{Zontrast 1 Zontrast ?
i BlueCol  vs Prof | craft  ve WhiteCal
Variable b gth g b std) e b std)
YWHITE -0.538 0.584 0.882 1.099  0.333 0.738
ED i 0878 0.415 0.075 0259 0772 0.466
EXFPER -0.03 0.870 0.545 0007 0993 0.803

Second, Table 2 presents information on predicted probabilities. At the top of the table, it shows the
predicted probabilities when the independent variables are at their base values, at their minimum, their
maximum, and their mean. Recall that these values are entered in Table 2 of Input. In the lower half of the
table, you can pick an independent variable and specified up to five values for that variable. Predicted
probabilities are computed for those values with all other variable held at the base val ues specified on
Input. To change base values, go back to Input and re-specify the base valuesin Table 1.

Table 2. Predicted Probability

All Variables Basic Predicted Probabilty
Held at Menial ElueCol Craft WhiteCol prof
Base: 0086 0.186 0.279 0167 0.2a81
Mean: 0094 0.1584 0.254 0161 0.266
Minimum: 0328 0516 0.154 0.002 0.000
Maximum;  0.000 0.000 0.00& 0.029 0.965

With offer variables held &t thelr base values,

Ienial BlueCol Craft WhiteCol prof
0 0217 0.136 0.439 0.088 0.120
i D0.086 0.185 0.279 0.167 0.281
1.0 white |
30122 0.718 0.153 0.007 0.000
Bi 0143 0.514 0.268 0.046 0.009
2 ed 13 0.088 0.193 0.264 0.166 0.268
18: 0006 0.008 0.03 0.066 0.890
_______________________________________ 22; 0000 0000 0002 0013 0884
0f 0136 0.268 0.251 013 0.215
5 0123 0.247 0.259 0.140 0.231
3.1 exper 10: 0110 0.227 0.267 0.149 0.245
20i 0.087 0.188 0.279 0167 0.260
300 0.068 0.153 0.285 0.183 0.311
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The Plotter Sheet

This sheet plots predicted probabilities as one independent variable changes holding all other variables at
their base value. In Table 1, you ender the name of the variable that changes, its start value, end value,
and the number of points to plot. Two tables and afigure are shown. Table 2 shows the base values (to
change the base values, go to Input and re-specify the values under the column Base Value. Table 2 shows
the values that are being plotted. Figure 1 presents the predicted probahilities as one variable changes.
Thisfigure can be edited within Excel to meet your needs.

The Change Sheet

This sheet calculates factor and discrete changes. Table 1 shows factor change in the odds of each
outcome relative to the base category for either a unit change or a standard deviation change in agiven
independent variable. The column labeled “ Type of Change” indicates if you want the coefficient for a
unit change (enter aU) or a standard deviation change (enter an S). Table 2 calculates discrete changesin
the predicted probabilities, all variables held at their bases. Base values are shown in Table 3 and were
entered on the Input sheet. Discrete changes from 0 to 1 will not be calculated if the variable is
continuous. For dummy variables, centered unit change and centered standard deviation change will not
be calculated. Note: 0 - 1 indicates achange from 0 to 1; Al indicates a centered change of 1 around the
base value; Ac is centered change of 1 standard deviation around the base value. ARange is change from
the minimum to maximum. Average A is the average absol ute discrete change.

glogit.xls: Generalized Ordered Logit

Thisworkbook operates in almost the same way as mlogit.xls. Please refer to the documentation for that
workbook.

The Input Sheet
There are no new issuesinvolved in entering data for glogit.xls.

The Calculator Sheet
This sheet computes predicted probabilities in the same way as Table 2 for mlogit.x|s.

The Plotter Sheet
This sheet operates in the same way as mlogit.xls.

The Change Sheet
This sheet computes predicted probabilities in the same way as Table 2 for mlogit.x|s.

count.xls: Poisson and negative binomial count models.

Thisworkbook is slightly different from the othersin that you can enter the estimates from two models,
the Poisson and NB, at the same time. This makes it very simple to compare the results of these two
models.

The Input Sheet

First, in Table 1 enter descriptive statistics for your dependent variable. In Table 2 enter descriptive
statistics, variable type, and base values for the independent variables.

Second, in Table 3, enter estimates from the Poisson regression model. If you are only interested in the
NB model, you can leave this table blank. In Table 4, enter estimates from the NB regression model.
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Under Alpha, enter the estimated o value. If you are only interested in the Poisson model, you can leave
this table blank.

Third, in Table 5, you can optionally enter the observed probabilities for your dependent variable. These
values are used by Plotter to compare observed and predicted counts.

The Calculator Sheet

This sheet computes predicted probabilities for each count. At the top of the sheet, you enter the highest
count value that you are interested in. For example, if you are interested in predicted probabilities for
counts form 0 to 10, you enter 10. The top part of Table 1 computes predicted counts with the
independent variables at their mean, minimum, maximum, and base values. The lower part of Table 2
computes predicted probabilities with all variables at their base values except for one variable. Y ou can
specify up to five values of this variable to see how changes in this variable affect the predicted
probabilities.

The Plotter Sheet

This sheet plots observed and predicted probabilities for each count value. Some basic information is
required for your plot. Thefirst piece of information is the number of count values that you want to plot.
Thisisusually equal to the number in the count for which you have observed praobabilities (see Columns
T and U in the Input page).

We provide three ways to compare the observed proportions to predictions. In all cases the observed
proportions are shown on the plot. Y ou are given three choices:

[ 2 1 (1) Univariate Mean; ( 2 Regression Mean; {3 ) Hypothetical Mean: ([ 20 )

e Option 1-Univariate Mean: computes the predicted probabilities from the Poisson and Negative
binomial distributions using the observed mean of the dependent variable. The o value estimated
by the regression is used in computing probabilities for the negative binomial distribution..

e Option 2-Regression Mean: computes the predicted probabilities from the Poisson and Negative
binomial distributions using the predicted rate from the regression models when all independent
variables are held at their base values. The o value estimated by the regression is used in
computing probabilities for the negative binomial distribution.

e Option 3-Hypothetical Mean: alows you to plot predictions with any mean value that you chose,
again using the o value estimated by the regression.

Three curves are then plotted in Figure 1. The specific values plotted are given in Table 1. You need to re-
specify the figure if you have a different number of counts. To do this, click on the figure, and go to Chart
-> Source Data. Table 2 displays the base values of your independent variables from the Input sheet.
Again, if you want to change the base values, go back to the Input page and re-specify the Base Value
column.

The Change Sheet

This page cal cul ates factor and discrete changes. Table 1 shows the factor and discrete changes in the
mean count (i.e., the rate) for changesin each independent variable for Poisson regression. Table 2
displays the same statistics for Negative Binomial regression. All predictions are calculated with all
variables held at their base values, as entered in Input and shown in Table 3. Discrete changesfrom 0to 1
will not be calculated if the variable is continuous. For dummy variables, centered unit change and
centered standard deviation change will not be calculated.
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